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Regulatory Compliance

The ADSP-CM403F EZ-KIT Lite is designed to be used solely in a labo-
ratory environment. The board is not intended for use as a consumer end
product or as a portion of a consumer end product. The board is an open
system design which does not include a shielded enclosure and therefore
may cause interference to other electrical devices in close proximity. This
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2004/108/EC and therefore carries the “CE” mark.

The EZ-KIT Lite evaluation system contains ESD (electrostatic discharge)

sensitive devices. Electrostatic charges readily accumulate on the human

body and equipment and can discharge without detection. Permanent dam- A
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precautions are recommended to avoid performance degradation or loss of ‘ % \
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PREFACE

Thank you for purchasing the ADSP-CM403F EZ-KIT Lite®, Analog
Devices, Inc. low-cost evaluation system for the ADSP-CM403F
mixed-signal control processor.

The ADSP-CM403F processor is based on the ARM® Cortex®-M4 pro-
cessor core and is designed for photovoltaic applications. The EZ-KIT
Lite is shipped with all of the necessary hardware—you can start the eval-
uation immediately. The package contains the standalone evaluation
board and CE-approved power supply. The EZ-KIT Lite version ships
with the J-Link Lite ARM, while the EZ-Board® version requires the cus-
tomer to provide a debugger.

Two expansion connectors (analog interface and PWM/digital interface)
are provided for connecting boards that incorporate motors. Another
expansion connector is provided for connecting an Anybus board and/or a
memory/FPGA extender card.

Traditional mechanical switches for changing the board’s factory setup
have been removed in favor of I*?C controlled software switches. The only
remaining mechanical switches are the boot mode switch and push
buttons.
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Product Overview

The evaluation board is designed to be used in conjunction with the IAR
Embedded Workbench development tools to test capabilities of the
ADSP-CM403F processors. The development environment aids advanced
application code development and debug, such as:

* Create, compile, assemble, and link application programs written
in C++, C, and assembly

* Load, run, step, halt, and set breakpoints in application programs
* Read and write data and program memory

* Read and write core and peripheral registers

Product Overview

The board features:
e Analog Devices ADSP-CM403F processor

* 120-pin LQFP package
* 30 MHz CLKIN core oscillator
* Universal Asynchronous Receiver/Transmitter (UARTO)
* Analog Devices ADM3252E RS-232 line transceiver

¢ DB9 female connector

e Controller Area Network (CAN) interface
* Analog Devices ADM3053 transceiver

* RJ11 connector

X ADSP-CM403F EZ-KIT Lite Evaluation System Manual



Preface

* Display
* New Haven NHD-0220D3Z-FL-GBW
* 2 x 20 character
e 2-wire interface (T'WI) control

e RESET controller

* Analog Devices ADM708 microprocessor supervisory
circuits

* Debug (JTAG/SWD/SWV/TRACE) interface
* JTAG/SWD 20-pin 0.1” header for use with IAR emulators
* Trace/JTAG/SWD/SWYV 20-pin 0.05” header

e LEDs

* Six LEDs: one power (green), one board reset (red), one
SYS_FAULT (red), and three general-purpose (amber)

e Push buttons
* Three push buttons: one reset, two IRQ/Flag
* Asynchronous connector

* 180-pin Samtec (QSH-090-01-F-D-A) 0.5 mm spacing
e SMCO address, data, and control

* CLKOUT
» SPIO

e UART2

« TWIO

* GPIOs

ADSP-CM403F EZ-KIT Lite Evaluation System Manual x1



Product Overview

RESET
GND/3.3V/5V output

* Pulse-width modulation (PWM) connector

180-pin Samtec (QSH-090-01-F-D-A) 0.5 mm spacing
PWMO-PWM?2
SINCO

SPI0

TWIO

T™MO

CNTO-CNT1
SPORT1

GPIO

RESET
GND/3.3V/5V output

5V input

* Analog connector interface

120-pin Samtec (QSH-060-01-F-D-A) 0.5 mm spacing
ADCO0-ADCI1

DACO0-1

AGND/GND/VREF/5V output

ADR441 voltage reference (VREF)

ADA4899 buffer—0.1” header for reference

Xil
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Preface

* External power supply

* CE compliant

* 5V@3.6 Amps

* Ability to power from the PWM connector
* Other features

* 0.05-ohm resistors for processor current measurement

For information about the hardware components of the EZ-KIT Lite,
refer to ADSP-CM403F EZ-KIT Lite Bill Of Materials.

Purpose of This Manual

The ADSP-CM403F EZ-KIT Lite Evaluation System Manual provides
instructions for installing the product hardware (board). The text
describes operation and configuration of the board components and pro-
vides guidelines for running your own code on the ADSP-CM403F
EZ-KIT Lite. Finally, a schematic and a bill of materials are provided for
reference.
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Intended Audience

Intended Audience

The primary audience for this manual is a programmer who is familiar
with an ARM Cortex-M4-based core.

The ADSP-CM40x family of mixed-signal control processors is based on
the ARM Cortex-M4 processor core with floating-point unit and inte-
grated SRAM memory, flash memory, accelerators, and peripherals.

The applicable documentation for programming the ARM Cortex-M4

processor core includes:
»  Cortex-M4 Devices Generic User Guide
o CoreSight ETM-M4 Technical Reference Manual
»  Cortex-M4 Technical Reference Manual

For additional information on this Analog Devices processor, see the
ADSP-CM40x Mixed-Signal Control Processor Hardware Reference. This
document describes the ARM Cortex-M4 processor core and memory
architecture used on the ADSP-CM40x processor, but does not provide
detailed programming information for the ARM core.

For more information about programming the ARM core, visit the ARM
Information Center:

http://infocenter.arm.com/help/

X1v
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Manual Contents

The manual consists of:

e Chapter 1, Using ADSP-CM403F EZ-KIT Lite
Describes EZ-KIT Lite functionality from a programmer’s perspec-
tive and provides a simplified memory map of the processor.

e Chapter 2, ADSP-CM403F EZ-KIT Lite Hardware Reference
Provides information about the EZ-KIT Lite hardware
components.

* Appendix A, ADSP-CM403F EZ-KIT Lite Bill Of Materials
Lists the hardware components used to manufacture the EZ-KIT
Lite.

e Appendix B, ADSP-CM403F EZ-KIT Lite Schematic
Lists the resources for board-level debugging.

What’s New in This Manual

This is the first edition (Revision 1.0) of the ADSP-CM403F EZ-KIT Lite
Evaluation System Manual.
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Technical Support

Technical Support

You can reach Analog Devices processors and DSP technical support in
the following ways:

Post your questions in the processors and DSP support community
at EngineerZone™:
http://ez.analog.com/community/dsp

Submit your questions to technical support directly at:
http://www.analog.com/support

E-mail your questions about processors and processor applications
to:

processor.support@analog.com or

processor.china@analog.com (Greater China support)

In the USA only, call 1-800-ANALOGD (1-800-262-5643)

Contact your Analog Devices sales office or authorized distributor.
Locate one at:
www.analog.com/adi-sales

Send questions by mail to:

Processors and DSP Technical Support
Analog Devices, Inc.

Three Technology Way

P.O. Box 9106

Norwood, MA 02062-9106

USA

Supported Processors

This evaluation system supports Analog Devices ADSP-CM403F

processors.

xvi
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Supported Tools

Information on supported tools for the ADSP-CM403F EZ-KIT Lite and
the ADSP-CM40x family of mixed-signal control processors is available
at:

http://www.analog.com/CM403FEZKit

Product Information

Product information can be obtained from the Analog Devices Web site
and the online help system.

Analog Devices Web Site

The Analog Devices Web site, www.analog.com, provides information
about a broad range of products—analog integrated circuits, amplifiers,
converters, and digital signal processors.

To access a complete technical library for each processor family, go to
http://www.analog.com/processors/technical_library. The manuals
selection opens a list of current manuals related to the product as well as a
link to the previous revisions of the manuals. When locating your manual
title, note a possible errata check mark next to the title that leads to the
current correction report against the manual.

Also note, myAnalog.com is a free feature of the Analog Devices Web site
that allows customization of a Web page to display only the latest
information about products you are interested in. You can choose to
receive weekly e-mail notifications containing updates to the Web pages
that meet your interests, including documentation errata against all manu-
als. myAnalog.com provides access to books, application notes, data sheets,
code examples, and more.
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Notation Conventions

Visit myAnalog.com (found on the Analog Devices home page) to sign up.
If you are a registered user, just log on. Your user name is your e-mail

address.

EngineerZone

EngineerZone is a technical support forum from Analog Devices. It allows
you direct access to ADI technical support engineers. You can search
FAQs and technical information to get quick answers to your embedded
processing and DSP design questions.

Use EngineerZone to connect with other DSP developers who face similar
design challenges. You can also use this open forum to share knowledge
and collaborate with the ADI support team and your peers. Visit
http://ez.analog.com to sign up.

Notation Conventions

Text conventions used in this manual are identified and described as

follows.

Example

Description

File > Close

Titles in reference sections indicate the location of an item within the
CCES environment’s menu system (for example, the Close command
appears on the File menu).

{this | that)

Alternative required items in syntax descriptions appear within curly
brackets and separated by vertical bars; read the example as this or
that. One or the other is required.

[this | that]

Optional items in syntax descriptions appear within brackets and sepa-
rated by vertical bars; read the example as an optional this or that.

[this,..]

Optional item lists in syntax descriptions appear within brackets delim-
ited by commas and terminated with an ellipse; read the example as an
optional comma-separated list of this.

xviil
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Example Description

SECTION Commands, directives, keywords, and feature names are in text with
letter gothic font.

filename Non-keyword placeholders appear in text with italic style format.

Note: For correct operation, ...
A Note provides supplementary information on a related topic. In the
online version of this book, the word Note appears instead of this

symbol.

®
N

Caution: Incorrect device operation may result if ...

Caution: Device damage may result if ...

A Caution identifies conditions or inappropriate usage of the product

that could lead to undesirable results or product damage. In the online
version of this book, the word Caution appears instead of this symbol.

N

‘Warning: Injury to device users may result if ...

A Warning identifies conditions or inappropriate usage of the product
that could lead to conditions that are potentially hazardous for the
devices users. In the online version of this book, the word Warning
appears instead of this symbol.

ADSP-CM403F EZ-KIT Lite Evaluation System Manual XX
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1 USING ADSP-CMA403F EZ-KIT
LITE

This chapter provides information to assist you with development of pro-

grams for the ADSP-CM403F EZ-KIT Lite evaluation system.

The following topics are covered.

Package Contents

ADSP-CM403F EZ-Board

Default Configuration

IAR Embedded WorkBench and Board Installation
IAR Embedded WorkBench Session Startup
SPI Flash

Analog Interface

UARTO Interface (RS-232)

CANO Interface

Debug Interface

Serial Liquid Crystal Display Module Interface
Power-On-Self Test

Expansion Interface

Power Architecture

ADSP-CM403F EZ-KIT Lite Evaluation System Manual 1-1



Package Contents

e DPower Measurements
* Example Programs
* Reference Design Information

For detailed information on how to program the ADSP-CM403F proces-
sor, refer to the documents listed in the Preface.

Package Contents

Your ADSP-CM403F EZ-KIT Lite package contains the following items:
* ADSP-CM403F EZ-KIT Lite board
e Universal 5V DC power
* J-Link Lite ARM (only in the EZ-KIT Lite version)

Contact the vendor where you purchased your EZ-KIT Lite or contact
Analog Devices, Inc. if any item is missing.
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Using ADSP-CM403F EZ-KIT Lite

ADSP-CM403F EZ-Board

The ADSP-CM403F EZ-KIT Lite is shipped with the J-Link Lite ARM
debugger. When the product is not shipped with the debugger, it is
referred to as the ADSP-CM403F EZ-Board.

@ The EZ-Board requires a third party emulator.

Default Configuration

The ADSP-CM403F EZ-KIT Lite board is designed to run outside your

personal computer as a standalone unit.

When removing the EZ-KIT Lite board from the package, handle the
board carefully to avoid the discharge of static electricity, which can dam-
age some components.

The EZ-KIT Lite evaluation system contains ESD (electrostatic discharge)
sensitive devices. Electrostatic charges readily accumulate on the human body

and equipment and can discharge without detection. Permanent damage may A
occur on devices subjected to high-energy discharges. Proper ESD precau- \
tions are recommended to avoid performance degradation or loss of function-

ality. Store unused EZ-KIT Lite boards in the protective shipping package.
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Default Configuration

Figure 1-1 shows the default jumper and boot mode switch settings used
in installation. Confirm that your board is in the default configuration
before using the board.

O swi
JP4
- P
. s
- P4

JP3

[ O JP2
L0 JP1

Figure 1-1. Default EZ-KIT Lite Hardware Setup
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Using ADSP-CM403F EZ-KIT Lite

IAR Embedded WorkBench and Board
Installation

For information about the IAR Embedded WorkBench® product and

software download, go to:
http://www.iar.com/en/Products/IAR-Embedded-Workbench

The ADSP-CM403F EZ-KIT Lite software, based on the IAR Embedded
WorkBench, can be found at:

http://www.analog.com/CM403FEZKit

Follow these instructions to ensure correct operation of the product soft-
ware and hardware.

Step 1: Connect the EZ-KIT Lite board to a personal computer (PC) run-
ning IAR Embedded WorkBench using a J-Link/]J-Trace emulator.

1. Plug one side of the USB cable into the USB connector of the emu-
lator. Plug the other side into a USB port of the PC running IAR
Embedded WorkBench.

2. Attach the emulator to the header connector, P1 or P2, on the

EZ-KIT Lite board.

Step 2: Attach the provided cord and appropriate plug to the 5V power
adaptor.

1. Plug the jack-end of the power adaptor into the power connector

P7 (labeled 5V) on the EZ-KIT Lite board.

2. Plug the other side of the power adaptor into a power outlet. The
power LED (labeled LEDS) is lit green when power is applied to the
board.

ADSP-CM403F EZ-KIT Lite Evaluation System Manual 1-5


http://www.iar.com/en/Products/IAR-Embedded-Workbench
http://www.analog.com/CM403FEZKit 

IAR Embedded WorkBench Session Startup

IAR Embedded WorkBench Session
Startup

It is assumed that the JAR Embedded WorkBench software is installed

and running on your PC.

1.

Navigate to the IAR Embedded WorkBench environment via the
Start menu.

Note that JAR Embedded WorkBench is not connected to the tar-
get board.

Choose File > Open >Workspace to open a workspace for the proj-
ect to download and debug.

Choose Project > Options.

The General Options, Target page appears.

In Processor variant, ensure Device is AnalogDevices
ADSP-CM40z-X_Y, where X is the SRAM size in KB and Y is the
internal flash size in KB of the part on the target board.

On the Analog Devices ADSP-CM403F EZ-KIT Lite, SRAM size
is 384 KB, and internal flash size is 2048 KB.

1-6
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Using ADSP-CM403F EZ-KIT Lite

5. Choose Debugger in the Category pane.

The Debugger, Setup options page appears.

a.

In Driver, choose J-Link/J-Trace as the emulator to be used

to debug the target board.

Click the Download tab. The Debugger, Download options
page appears.

Ensure Use flash loader(s) is enabled. Note that other
download settings are optional.

6. Choose Debugger > J-Link/]J-Trace in the Category pane.

The emulator Setup options page appears.

a.

On the Setup page,

In Reset, select Connect during reset from the drop-down
list.

In JTAG/SWD speed, select Auto.

(Optional) In Clock setup, change the default values.
On the Connection page,

In Communication, select USB and Device 0.

In Interface, select JTAG or SWD.

7. Click OK to save the emulator settings.

8. Choose Project > Debug and Download to download the project
and start debugging.
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SPI Flash

SPI Flash

The EZ-KIT Lite ships with an internal 4 MB SPI flash, connected via the
SPI2 interface, which is used for booting and scratchpad space. Refer to
the ADSP-CM40x Mixed-Signal Control Processor Hardware Reference for

more information about the internal SPI flash.

For more information, refer to the SPI flash example in the POST, which
is included in the ADSP-CM40x Enablement Software.

Analog Interface

The ADSP-CM403F processor provides two 16-bit ADCs with 12 inputs
each, ADCO and ADC1. The ADC signals are connected to the Analog expan-
sion connector (J9). There are also two 12-bit DACs available on J9.

Refer to ADSP-CM403F EZ-KIT Lite Schematic for more information.

Voltage reference for the ADC channels can be supplied internally from
the processor or externally by ADR441 ICs. U6 is the VREFO supply exter-
nal source, and U2 is its VREF1 equivalent. To select the external source for
either supply, place a jumper on JP1 or JP2. Refer to ADSP-CM403F
EZ-KIT Lite Schematic for more information.

A buffered version of the voltage reference is available on J9 via a unity
gain buffer ADA4889 (U22). By default, the internal VREFO source is
selected as the input to the buffer (JP3 positions 1 and 2). If the external
voltage reference is desired, change the jumper to JP3 positions 2 and 3.

Voltage references for the analog inputs are configurable; refer to Jumpers
for more information.

1-8 ADSP-CM403F EZ-KIT Lite Evaluation System Manual



Using ADSP-CM403F EZ-KIT Lite

UARTO Interface (RS-232)

The ADSP-CM403F processor has three built-in universal asynchronous
transmitters (UART's). UARTO is connected to a RS-232 line transmitter.
UARTO has full RS-232 functionality via the Analog Devices ADM3252E
isolated line driver and receiver (U23).

The EZ-KIT Lite voltage isolation components are not intended
for protecting external products. The isolated ICs are used to show-
case Analog Devices product portfolio only. Adequate voltage
isolation of any external devices/boards is the user responsibility.

Pin PC_02/UARTO_TX/TRACE_DO3/SPI0_RDY of the processor is connected to
the ADM3315 device directly and used for UART transmit.

Pin PC_01/UARTO_RX/SMCO_A05/TMO_ACI5 is connected through SoftConfig
by default and used for UART receive. (This can be changed through
SoftConfig.)

By default, the UARTO CTS signal is not connected, and the UARTO RTS sig-
nal is connected to RS-232. Both connections can be changed through

SoftConfig.

The SoftConfig switches also allow the loopback of CTS and RTS. The
UARTO CTS can be added as an input to the reset circuit through SoftCon-
fig. Refer to Software-Controlled Switches (SoftConfig) for more

information.

For more information, refer to the UART example in the POST, which is
included in the ADSP-CM40x Enablement Software. Note that the loop-
back of TX and RX data is done through an external connector.
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CANO Interface

CANDO Interface

The Controller Area Network 0 (CANO) interface of the EZ-KIT Lite is
connected to the Analog Devices ADM3053 isolated CAN transceiver
(U26). The transceiver is attached to the CANO port of the ADSP-CM403F
processor via an RJ-11 connector (J8). See CANO Connector (J8).

The EZ-KIT Lite voltage isolation components are not intended
for protecting external products. The isolated ICs are used to show-
case Analog Devices product portfolio only. Adequate voltage
isolation of any external devices/boards is the user responsibility.

The CANO transmit and receive signals are connected through the Soft-
Conlfig switches and enabled by default. See Software-Controlled Switches
(SoftConfig).

For more information, refer to the CANO example in the POST, which is
included in the ADSP-CM40x Enablement Software.

Debug Interface

The EZ-KIT Lite provides a JTAG/SWD/SWYV connection via a connec-
tor (P1), which is a 0.1” header. A 4-bit trace connection also includes
JTAG/SWD/SWYV and is available via a connector (P2). See
JTAG/SWD/SWV Connector (P1) and TRACE and JTAG/SWD/SWV

Connector (P2) for more information.

Serial Liquid Crystal Display Module
Interface

Connector J3 mates with the Newhaven Display International
NHD-0220D3Z-FL-GBW-V3, a 2-line by 20-character display with a
yellow/green backlight.
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The display is written using the TWI interface. The TWI address of the
display is 0x50. The maximum clock rate for the display is 100 kHz. The
display can be removed if the frequency limitation poses a problem.

For more information, refer to the serial liquid crystal display example in

the POST, which is included in the ADSP-CM40x Enablement Software.

Power-On-Self Test

The Power-On-Self-Test Program (POST) tests all EZ-KIT Lite peripher-
als and validates functionality as well as connectivity to the processor.
Once assembled, each EZ-KIT Lite is fully tested for an extended period
of time with POST. All EZ-KIT Lite boards are shipped with POST pre-
loaded into flash memory. The POST is executed by resetting the board
and pressing the proper push button(s). The POST also can be used as a
reference for a custom software design or hardware troubleshooting.

Note that the source code for the POST program is included in the
ADSP-CM40x Enablement Software along with the readme. txt file that
describes how the board is configured to run POST.

Expansion Interface

The expansion interface allows a custom-design daughter board to be
tested across various hardware platforms that have the same expansion
interface.

The expansion interface implemented on the ADSP-CM403F EZ-KIT
Lite consists of three connectors: Asynch or Memory Connector (J2),
PWM Connector (J7), and Analog Connector (J9). The connectors con-
tain a majority of the processor’s signals. For pinout information, go to

ADSP-CM403F EZ-KIT Lite Schematic.
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Limits to current and interface speed must be taken into consideration
when using the expansion interface. Current for extenders connected to J2
or J6 can be sourced from the EZ-KIT Lite; therefore, the current should
be limited to 250 mA for 5V, and 200 mA from the 3.3V planes. If more
current is required, a separate power connector and a regulator must be
designed on the daughter card. Additional circuitry implemented on
extender cards can add extra loading to signals, decreasing their maximum
effective speed.

Analog Devices does not support and is not responsible for the
effects of additional circuitry.

Power Architecture

The ADSP-CM403F EZ-KIT Lite has two primary voltage domains: 3.3V
and 1.2V. The main input is a 5V wall adaptor. The 5V source can be
selected via JP4 to input from the PWM connector (J7) as an alternative

to the wall power adaptor. Refer to PWM Connector (J7) and Power
Select Jumper (JP4) for details.

The Analog Devices ADP2119 controller provides 3.3V for the VDD_EXT
signal and the 3.3V power requirements of the board. The VDD_INT signal
is delivered through either Analog Devices regulator ADP2119 (VR1) or a
PNP transistor (Q1).

Power Measurements

Locations are provided for measuring the current draw from various power
planes. Precision 0.05 ohm shunt resistors are available on the

VDD_EXT, VDD_INT, and 3.3V voltage domains. For current draw, the
jumper is removed, voltage across the resistor can be measured using an
oscilloscope, and the value of the resistor can be measured using a preci-
sion multi-meter. Once voltage and resistance are measured, the current
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can be calculated by dividing the voltage by the resistance. For the highest
accuracy, a differential probe should be used for measuring the voltage
across the resistor. For more information, refer to Power Jumpers (P4-0).

Example Programs

Example programs are provided with the ADSP-CM40x Enablement Soft-
ware to demonstrate various capabilities of the product. The programs can
be found in the CM403F_CM408F_EZ-KIT\examples folder. Refer to a
readme file provided with each example for more information.

Reference Design Information

A reference design info package is available for download on the Analog
Devices Web site. The package provides information on the design, lay-
out, fabrication, and assembly of the EZ-KIT Lite.

The information can be found at:

http://www.analog.com/CM403FEZKit

ADSP-CM403F EZ-KIT Lite Evaluation System Manual 1-13


http://www.analog.com/CM403FEZKit 

Reference Design Information

1-14 ADSP-CM403F EZ-KIT Lite Evaluation System Manual



2 ADSP-CM403F EZ-KIT LITE
HARDWARE REFERENCE

This chapter describes the hardware design of the ADSP-CM403F
EZ-KIT Lite board.

The following topics are covered.

System Architecture
Describes the board’s configuration and explains how the board
components interface with the processor.

Software-Controlled Switches (SoftConfig)
Lists and describes the processor signals routed through the soft-
ware-controlled switches.

Push Buttons and Switches
Shows the locations and describes the push buttons and switches.

Jumpers
Shows the locations and describes the configuration jumpers.

LEDs
Shows the locations and describes the LEDs.

Connectors

Shows the locations and provides part numbers for the on-board
connectors. In addition, the manufacturer and part number infor-
mation is provided for the mating parts.

ADSP-CM403F EZ-KIT Lite Evaluation System Manual
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System Architecture

System Architecture

This section describes the processor’s configuration on the EZ-KIT Lite
(Figure 2-1).

30 MHz ! ;
Oscillator RS-232 ADI .
3.3 Volts ADM3252E EDMaosa ‘ LEDs (3) ‘ PBs (2)

A L

A

zZ
= ‘UARTO‘ ‘CANO‘ ‘ GPIO }4— UART2 SMCo
o
Mbit Quad
ADSP-CM403F P Pl
. SPI0
e TMRO:2

2 16-bit ADCs| 2 12-bit 4 A
12inputs each)  DACs ‘PWMO:Z‘ ‘ SINCO ‘ ‘CNTO:1‘ ‘ TWIO

A
* Yyvy |

Figure 2-1. EZ-KIT Lite Block Diagram

This EZ-KIT Lite is designed to demonstrate the ADSP-CM403F proces-
sor’s capabilities. The ADSP-CM403F EZ-KIT Lite has a 30 MHz input
clock and runs at 240 MHZ internally.
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User I/O to the processor is provided in the form of two user push buttons
and three LEDs. The software-controlled switches (SoftConfig) facilitate
the switch multi-functionality by disconnecting the push buttons from
their associated processor pins and reusing the pins elsewhere on the
board. See ADSP-CM403F EZ-KIT Lite Schematic for more information.

Software-Controlled Switches
(SoftConfig)

On the ADSP-CM403F EZ-KIT Lite, most of the traditional mechanical
switches have been replaced by I°C software-controlled switches. The
remaining mechanical switches are provided for changing the boot mode
and push buttons. Reference any SoftConfig*.c file found in the installa-
tion directory for an example of how to set up the SoftConfig feature of

the ADSP-CM403F EZ-KIT Lite through software.

The SoftConfig section of this manual serves as a reference to any user
that intends to modify an existing software example. If software provided
from ADI is used, there should be little need to reference this section.

Care should be taken when changing SoftConfig settings not to
create a conflict with interfaces. This is especially true when con-
necting extender cards.

Overview of SoftConfig

In order to further clarify the use of electronic single FET switches and
multi-channel bus switches, an example of each is illustrated and com-
pared to a traditional mechanical switching solution. This is a generic

example that uses the same FET and bus switch components that are on
the EZ-KIT Lite.

After this generic discussion there is a detailed explanation of the Soft-

Conlfig interface specific to the ADSP-CM403F EZ-KIT Lite.
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Figure 2-2 shows two individual FET switches (Pericom PI3A125CEX)
with reference designators UA and UB. Net names ENABLE_A and ENABLE_
B control UA and UB. The default FET switch enable settings in this
example are controlled by resistors RA and RB which pull the enable pin 1
of UA and UB to ground (low). In a real example, these enable signals are
controlled by the Microchip 1O expander. The default pull-down resistors
connects the signals EXAMPLE_SIGNAL_A and EXAMPLE_SIGNAL_B and also
connects signals EXAMPLE_SIGNAL_C and EXAMPLE_SIGNAL_D. To disconnect
EXAMPLE_SIGNAL_A from EXAMPLE_SIGNAL_B, the Microchip IO expander is
used to change ENABLE_A to a logic 1 through software that interfaces with
the Microchip. The same procedure for ENABLE_B disconnects EXAMPLE_
SIGNAL_C from EXAMPLE_SIGNAL_D.

UA
ENABLE_A = I5g
EXAMPLE_SIGNAL A m A B m EXAMPLE SIGNAL B
TATIS
SC70 5
UB
ENABLE B ® Be
EXAMPLE_SIGNAL C = i B @ EXAMPLE SIGNAL D
TATIS
SC70 5
>RA >RB
0K \_?*WOK
<, 0402, 0402

.

NS

Figure 2-2. Example of Individual FET Switches
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Figure 2-3 shows the equivalent circuit to Figure 2-2 but utilizes mechan-
ical switches that are in the same package. Notice the default is shown by
black boxes located closer to the 0N label of the switches. In order to dis-
connect these switches, physically move the switch to the 0FF position.

SWA
EXAMPLE_SIGNAL A m— 1 [ JE ' m EXAMPLE_SIGNAL B
[ |

EXAMPLE_SIGNAL_C m—2&.

DIP2
SWT020

F—a EXAMPLE_SIGNAL_D

Figure 2-3. Example of Mechanical Switch Equivalent to Figure 2-2

Figure 2-4 shows a bus switch example, reference designator UC (Pericom
PI3BLVD512ZHE), selecting between lettered functionality and numbered
functionality. The signals on the left side are multiplexed signals with
naming convention letter_number. The right side of the circuit shows the
signals separated into letter and number, with the number on the lower
group (eg. 0B1) and the letter on the upper group (eg. 082). The default
setting is controlled by the signal CONTROL_LETTER_NUMBER which is pulled
low. This selects the number signals on the right to be connected to the
multiplexed signals on the left by default. In this example, the Microchip
IO expander is not shown but controls the signal CONTROL_LETTER_NUMBER
and allows the user to change the selection through software.

Figure 2-5 shows the equivalent circuit to Figure 2-4 but utilizes mechan-
ical switches. Notice the default for reference designators SWC and SWD is
illustrated by black boxes located closer to the 0N label of the switches to
enable the number signals by default. Also notice the default setting for
reference designators SWE and SWF is OFF. In order to connect the letters
instead of the numbers, the user physically changes all switches on SWC and
SWD to the OFF position and all switches on SWE and SEF to the ON position.
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Figure 2-4. Example of Bus Switch
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Figure 2-5. Example of Mechanical Switch Equivalent to Figure 2-4

SoftConfig on the ADSP-CM403F EZ-KIT LITE

The Microchip MCP23017 GPIO expander (U27) provides control for
individual electronic switches. The TWIO interface of the processor com-
municates with the Microchip device.

Table 2-1 lists the ADSP-CM403F processor and EZ-KIT Lite interfaces
that are available by default. Note that only interfaces affected by software
switches are listed in Table 2-1.
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Table 2-1. Default ADSP-CM403F Processor Interface Availability

Interface Availability by Default

UARTO RS-232 RX, TX and RTS enabled by default. SoftConfig required for other
functionality.

CANO Enabled in hardware, disabled in software to use LED1.

Push buttons Enabled

LEDs Enabled

Programming SoftConfig Switches

On the ADSP-CM403F EZ-KIT Lite, one Microchip MCP23017 device
exists. The device has the following programming characteristics:

* Each switch has two programmable GPIO registers.

GPIO Register Register Address
GPIOA 0x12
GPIOB 0x13

Each GPIO register controls eight signals (software switches).

* By default, the Microchip MCP23017 GPIO signals function as
input signals.

The signals must be programmed as output signals to override their
default values. The following table shows the Microchip register
addresses and the values that must be written to them to program
the signals as output signals.

IODIR Register [IODIR Register Address |Value to be Written to Program Signals
as Outputs

IODIRA 0x00 0

IODIRB 0x01 0
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Each of the software examples include a source file that programs the soft
switches, even if the default settings are being used. The README for each
example identifies only the signals that are being changed from their
default values. The code that programs the soft switches is located in the
SoftConfig_CM408F.c file in each example.

Table 2-2 outlines the default values for the Microchip MCP23017

device.

Table 2-2. I*C Hardware Address 0x40

GPIO MCP23017 Register Address Default Value
GPIOA 0x12 0xE0
GPIOB 0x13 0xC1

The ADSP-CM403F EZ-KIT Lite Schematic shows how the Microchip
GPIO expander (U27) is connected to the board’s ICs. All outputs drive
single signal FET switches. The CANO and LED1 circuits both use pro-
cessor port pin PB_15, and can be selected through SoftConfig. CANO
enable (CANO_ENO) controls whether the CAN port is enabled or the signals
are connected to the expansion interface. When CANO_EN is low, the CAN
interface is enabled and the processor signals (PC_00 and PB_15) are not
connected to the expansion interface. A CANO_EN setting of high connects
the signals to the expansion interface and disconnects the CAN port. This
is done through the inverter IC (U3).

Table 2-3 and Table 2-4 show the output signals of the Microchip GPIO
expander (U27), with a TWI address of 0100 001X, where X represents the
read or write bit. The signals that control an individual FET have an entry
under the FET column. The Component Connected column shows the
board IC that is connected if the FET is enabled. Also note that if a
particular functionality of the processor signal is being used, it will be in
bold font under the Processor Signal column.
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(U27 Port A)

Table 2-3. Output Signals of Microchip GPIO Expander

Bit |Signal Name Description FET |Processor Signal Component | Default
(if applicable) Connected

0 Not used Low

1 PB_10_J7_EN Processor pin PB_10 [ U8 |PB_10/SINCO_CLKO/ Low
connection to expan- SPI0_D2/CAN1_RX/
sion connector J7 SMCO_AWE/TMO_ACI1

2 | PB_11_J7_EN Processor pin PB_11 U9 | PB_11/SINCO_DO/ Low
connection to expan- SPIO_D3/CAN1_TX/
sion connector J7 SMCO_AMSO/TMO_ACLK1

3 UARTORTS_EN UARTO RTS U10 | PB_04/PWM2_SYNC/ uz3 Low
connected to RS-232 UARTO_RTS/SPTO_
transceiver ATDV/SMCO_D12/CNT1_

ub

4 UARTORX_EN UARTO0 RX U1l [ PC_O1/UARTO_RX/ uz3 Low
connected to RS-232 SMCO_AO05/TMO_ACIb5
transceiver

5 UARTOCTS_EN UARTO0 CTS Ul2 | PB_O5/PWM2_TRIPO/ U36 High
disconnected from UARTO_CTS/TMO_TMR7/
RS-232 transceiver SMCO_D13/CNT1_DG
by default

6 UARTOCTS_RTS_LPBK | UARTO CTS and U13 u36 High
RTS not connected.
Change to low for
looping back RS-232
CTS and RTS signals

7 UARTOCTS_RST_EN UARTO CTS Signal ul4 U36 High
not connected to
input of reset IC
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Table 2-4. Output Signals of Microchip GPIO Expander

(U27 Port B)

Bit|Signal Name Description FET |Processor Signal Component | Default
(if applicable) Connected
0 | CANO_EN Enables CAN 0, U155/ | PC_O0/CANO_TX/ uze Low
enabled by default Ule | SPTI_BTDV/UARTI_
TX/SMCO_A04 and PB_
15/CANO_RX/SPT1_
ATDV/UARTI_RX/
SMCO_AQ03/TMO_ACI4
1 PUSHBUTTONI_EN PF_10 is used as GPIO |U21 PF_10/ETHO_ U39 Low
input for push button PTPCLKIN
1, enabled by default
2 | PUSHBUTTONZ_EN PE_08 is used as GPIO | U20 PE_08/ETHO_PTPPPS/| U39 Low
input for push button SMCO_A22/CNT2_ZM
2, enabled by default
3 | LED1I_GPIO_EN PE_07 is used as GPIO | U19 PE_07/ETHO_ ub Low
output for LEDI, PTPAUXIN/SMCO_A21
enabled by default
4 | LED2_GPIO_EN PE_06 is used as GPIO | U18 PE_06/SMCO_A20 us Low
output for LED2,
enabled by default
5 | LED3_GPIO_EN PE_05 is used as GPIO |U17 PE_05/SMCO0_A19 ub Low
output for LED3,
enabled by default
6 | TRACE_EXP_EN Signals not connected Us1- | PB_00O, PB_01, PB_ |[J2,Jd7 High
to expansion interface 55 02, PB_03, PC_02
7 | SPIFLASH_J2_EN Signals not connected U32- | PC_03, PC_05, PC_ |J2 High
to expansion interface | 36 04, PB_10, PB_11
by default
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Push Buttons and Switches

This section describes operation of the push buttons and switches. The
push button and switch locations are shown in Figure 2-6.

SW3  Sw4

Figure 2-6. Push Button and Boot Mode Switch Locations
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Boot Mode Select Switch (SW1)

The rotary switch (SW1) determines the boot mode of the processor.
Table 2-5 shows the available boot mode settings. By default, the
ADSP-CM403F processor boots from the on-board burst flash memory.

Table 2-5. Boot Mode Select Switch (SW1)

SW1 Position Processor Boot Mode

0 No Boot — Idle
1

SPI master boot (internal SPI2). Default boot mode.
SPI slave boot (SPI0)

2

3 UART boot (UARTO0)

Reset Push Button (SW2)

The reset push button (SW2) resets the processor (U1) and the GPIO

extender (U27). The reset also is connected to the expansion interface via
the SYS_HWRST signal.

GPIO Push Buttons (SW3-4)

The GPIO push buttons (SW3 and SW4) are connected to the processor’s
signals PB_06/PWM2_AH/TMO_CLK/SMCO_D14 and PB_07/PWM2_AL/TMO_TMRO/
SMC0_D15, respectively. The signals are connected by default.
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Jumpers

This section describes functionality of the configuration jumpers.
Figure 2-7 shows the jumper locations.

JP4
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0 P4

e C
V0T
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Figure 2-7. Jumper Locations

2-14 ADSP-CM403F EZ-KIT Lite Evaluation System Manual



ADSP-CM403F EZ-KIT Lite Hardware Reference

VREFO External Source Jumper (JP1)

The VREFO external source jumper (JP1) selects whether an internal or
external voltage reference supplies the VREFO signal of the processor. When
a jumper on JP1 is not installed (default), the internal voltage reference
supplies VREFO. When a jumper on JP1 is installed, the external Analog
Devices ADR441 ultra-low noise voltage reference (U6) supplies VREFO.
Configure the processor’s registers accordingly for the latter case.

VREF1 External Source Jumper (JP2)

The VREF1 external source jumper (JP2) selects an internal or external volt-
age reference supply to the VREF1 signal of the processor. When a jumper
on JP2 is not installed (default), the internal voltage reference supplies
VREF1. When a jumper on JP? is installed, the external Analog Devices
ADR441 ultra-low noise voltage reference (U2) supplies VREF1. Configure
the processor’s registers accordingly for the latter case.

Buffer Input Select Jumper (JP3)

The buffer input select jumper (JP3) selects the input to the ADA4889
unity gain op amp buffer (U22). The processor’s internal input is selected
by placing a jumper on pins 1 and 2 of JP3 (default).

The external VREFO input, supplied by the Analog Devices ADR441
ultra-low noise voltage reference (U6), is selected by placing a jumper on
pins 2 and 3 of JP3.
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Power Select Jumper (JP4)

The power select jumper (JP4) selects the wall power (5V) when a jumper
is placed on positions 1 and 2. When a jumper is placed on positions 2
and 3, power from pins 177, 178, 179 and 180 of the PWM connector

(37) is supplied to the board. The default setting is positions 1 and 3,
which selects wall power.

Power Jumpers (P4-6)

Remove jumpers listed in Table 2-6 to measure the respective voltage
across the adjacent sense resistor.

Table 2-6. Power Jumpers

Power Jumper Resistor
P4 VDD_INT
P5 VDD_EXT
P6 3.3V
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LEDs

This section describes the on-board LEDs. Figure 2-8 shows the LED
locations.

LED4
ams]

- LED6
LEDS

LEDs

o oo oo

123

Figure 2-8. LED Locations
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GPIO LEDs (LED1-3)

Three LEDs are connected to the general-purpose I/O pins of the proces-
sor (see Table 2-7). The LEDs are active high and are ON (amber) by
writing a 1 to the correct processor signal.

Table 2-7. GPIO LEDs

LED Reference Designator Processor Programmable Flag Pin
LED1 PB_15
LED2 PB_04
LED3 PB_05

Reset LED (LED4)

When LED4 is ON (red), it indicates that the master reset of all the major
ICs is active. The reset LED is controlled by the Analog Devices ADM708
supervisory reset circuit. A master reset is asserted by pressing SW2 which
activates LED4. For more information, see Reset Push Button (SW2).

Power LED (LEDS5)

When LED5 is ON (green), it indicates that power is being supplied to the
board properly. For more information, see Power Architecture.

SYS_FAULT LED (LED6)

When LED6 is ON (red), it indicates a system fault. For more information,
refer to the ADSP-CM40x Mixed-Signal Control Processor Hardware
Reference.
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Connectors

This section describes connector functionality and provides information
about mating connectors. The connector locations are shown in

Figure 2-9.

DP7 = E

P |
1 P2

J3

J7

J1

J9

J8

Je

Figure 2-9. Connector Locations

@ Connectors on the back of the board are noted with dotted lines.
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DCE UART Connector (J1)

Part Description

Manufacturer

Part Number

DBY9 female

NORCOMP

191-009-213-L-571

Asynch or Memory Connector (J2)

Part Description

Manufacturer

Part Number

180-pin high speed socket

SAMTEC

QSH-090-F-D_A

Mating Connector

180-pin high speed header

SAMTEC

QTH-090-01-F-D-A

Character Display Connector (J3)

The character display connector (J3) is a socket that mates with the 20 x 2

character display.

Part Description

Manufacturer

Part Number

IDC 5x2 SMT

SAMTEC

SSW-105-22-F-D-VS

Mating Connector

20x2 character display with back-
light

NEW HAVEN DISPLAY

NHD-0220D3Z-FL-GBW
(requires header)
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PWM Connector (J7)

Part Description

Manufacturer

Part Number

180-pin high speed socket

SAMTEC

QSH-090-F-D_A

Mating Connector

180-pin high speed header SAMTEC QTH-090-01-F-D-A
CANO Connector (J8)

Part Description Manufacturer Part Number

RJ11 vertical DIGIKEY A31431-ND

Mating Connector

RJ11 cable
Analog Connector (J9)
Part Description Manufacturer Part Number
120-pin high speed socket SAMTEC QSH-060-F-D_A

Mating Connector

120-pin high speed header

SAMTEC

QTH-060-01-F-D-A

JTAG/SWD/SWV Connector (P1)
The JTAG/SWD/SWYV header (P1) provides debug connectivity for the

microprocessor. This is a 0.1” connector from SAMTEC
(SHF-110-01-L-D-TH). For more information, see Debug Interface.

ADSP-CM403F EZ-KIT Lite Evaluation System Manual 2-21




Connectors

TRACE and JTAG/SWD/SWV Connector (P2)

The TRACE and JTAG/SWD/SWV Connector (P2) provides connectiv-
ity to the microprocessor’s trace interface. This is a 0.05” connector from

TE Connectivity (5103308-5).

Pin 7 is cut to provide keying.

Refer to the SoftConlfig tables for information on enabling the Trace sig-
nals, specifically the TRACE_EXP_EN signal.

VREF Buffered Connector (P3)

The VREF buffered connector provides a means to measure the voltage of
the voltage reference. There is an adjacent analog grounding point (TP11).

Power Connector (P7)

Part Description Manufacturer Part Number
0.65 mm power jack CUI 045-0883R
Mating Connector
5.0VDC@3.6A power supply GLOBETEK GS-1750(R)
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A ADSP-CM403F EZ-KIT LITE
BILL OF MATERIALS

The bill of materials corresponds to ADSP-CM403F EZ-KIT Lite

Schematic.
Ref. | Qty | Description Reference Manufacturer Part Number
Designator
1 1 ADM708SARZ SOIC8 | U28 ANALOG ADM708SARZ
DEVICES
2 1 ADP2119ACPZ-R7 VR1 ANALOG ADP2119ACPZ-R7
DFN50P300X300-11N DEVICES
3 2 ADR441ARMZ U2,U6 ANALOG ADR441ARMZ
MSOP8 DEVICES
4 1 ADP2118ACPZ VR2 ANALOG ADP2118ACPZ
QFN65P400X400X80- DEVICES
17N
5 1 ADA4899 SOICS8 U22 ANALOG ADA4899-1YRDZ-R7
DEVICES
6 1 ADM3252E U23 ANALOG ADM3252EABCZ
BGA44C100P11X11_ DEVICES
1200X1200X103
7 1 ADM3053 U26 ANALOG ADM3053BRWZ
SOIC127P1032X265-2 DEVICES
ON
8 1 ADSP-CM403FBSWZ | Ul ANALOG ADSP-CM403FBSWZENG
QFPS40P1600X1600X DEVICES
160-121N
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Ref. | Qty | Description Reference Manufacturer Part Number
Designator
9 47 | 0.1UF 10V 10% 0402 C1,C7,C8,C1 | AVX 0402ZD104KAT2A
1,C13,C16,C
19,C22,C25-
C30,C33,C42
-C44,C49,C5
1,C52,C55,C
56,C60,C63-
C66,C68,C72
-C74,C76,C7
7,C79,C95,C
99-C104,C11
1,C113-C115,
Cl74
10 37 | 0.01UF 16V 10% 0402 | C4-C6,C21,C | AVX 0402YC103KAT2A
23,C34-C40,
C48,C67,C69
,C71,C80-C8
9,C105-C110,
C112,C170-C
173
11 1 10UF 16V 10% 1210 C93 AVX 1210YD106KAT2A
12 2 1000PF 50V 5% 1206 C92,C94 AVX 12065A102JAT2A
13 2 680 1/16W 1% 0402 R140,R141 BC COMPO- 2312 275 16801
NENTS
14 |2 1.5UH 20% INDO003 L1,L2 COIL CRAFT DO1608C-152MLC
15 |1 ROTARY SWT027 SW1 COPAL S-8110
16 1 MCP23017 u27 DIGI-KEY MCP23017-E/ML-ND
QFN65P600X600-29N
17 |1 GREEN LED_0603 LED5 DIGI-KEY 475-1409-2-ND
18 | 3 0.1UF 16V 10% 0402 | C57-C59 DIGI-KEY 587-1451-2-ND
19 1 30MHZ OSC012 U25 DIGI-KEY 300-8257-1-ND
20 | 2 RED LED_0603 LED4,LED6 DIGI-KEY 475-2512-2-ND
21 3 YELLOW LED_0603 LEDI1-LED3 DIGI-KEY 475-2558-1-ND
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ADSP-CM403F EZ-KIT Lite Bill Of Materials

Ref. | Qty | Description Reference Manufacturer Part Number
Designator
22 1 10UF 6.3V 20% 0402 C15 DIGI-KEY 445-8920-1-ND
23 1 STD2805T4 Q1 DIGI-KEY 497-7465-1-ND
TO228P972X240-3N
24 |7 IDC 2PIN_JUMPER_ | SJ1-S]J7 DIGI-KEY S9001-ND
SHORT
25 |1 PWR .65MM CONO045 | P7 DIGI-KEY CP1-023-ND
26 |1 1K 1/10W 5% 0603 R20 DIGI-KEY 311-1.0KGRTR-ND
27 1 4700PF 16V 10% 0603 | C70 DIGI-KEY 311-1083-2-ND
28 | 2 100 1/16W 5% 0402 R95,R96 DIGI-KEY 311-100JRTR-ND
29 | 6 330.0 1/16W 1% 0402 | R28,R77-R80, | DIGI-KEY 541-330LCT-ND
R91
30 | 6 IDC 2X1 IDC2X1 JP1,JP2,P3-P6 | FCI 90726-402HLF
31 2 IDC 3X1 IDC3X1 JP3,]P4 FCI 90726-403HLF
32 1 IDT74FCT3244APY Us IDT IDT74FCT3244APYG
SSOP20
33 1 TEST LOOP LOOP_ GP1 KEYSTONE 5016
2838
34 3 0 1/4W 5% 1206 R15,R21,R13 | KOA 0.0ECTRk7372BTTED
8
35 1 IDC 10X2 TE_ P1 MOUSER 571-5103308-5
5103308-5
36 |7 10UF 6.3V 20% 0603 C9,C10,C18, | MULTICOMP | MCCA000517
C24,C31,C32
,C41
37 1 190 100MHZ 5A FER3 MURATA DLW5BSN191SQ2
FER002
38 1 DB9 9PIN CONO038 J1 NORCOMP 191-009-213-L-571
39 1 GTL2002 TSSOP8 U24 NPX GTL2002DP118
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Ref. | Qty | Description Reference Manufacturer Part Number
Designator
40 3 5A MBRS540T3G D4,D6,D7 ON SEMI MBRS540T3G
SMC
41 3 MOMENTARY SW2-SW4 PANASONIC EVQ-Q2K03W
SWT024
42 13 | 01/16W 5% 0402 R6,R7,R19,R | PANASONIC ERJ-2GEOR00X
32,R37,R103,
R108,R110,R
122,R131,R13
3,R135,R139
43 25 0 1/16W 5% 0402 R5,R18,R33, PANASONIC ERJ-2GEOR00X
R36,R68,R10
5,R106,R111,
R114-R119,R
121,R123,R12
7,R128,R132,
R134,R136,R
137,R147-R1
49
44 3 1UF 6.3V 20% 0402 C17,C90,C91 | PANASONIC ECJ-0EB0J105M
45 7 10UF 10V 10% 0805 C12,C14,C20 | PANASONIC ECJ-2FB1A106K
,C61,C62,C7
5,C78
46 2 27K 1/16W 5% 0402 R30,R31 PANASONIC ERJ-2GEJ273X
47 2 60.4 1/10W 1% 0603 R67,R70 PANASONIC ERJ-3EKF60R4V
48 1 45.3K 1/10W 1% 0402 | R113 PANASONIC ERJ-2RKF4532X
49 1 24.9 1/10W 1% 0402 R12 PANASONIC ERJ-2RKF24R9X
50 1 10UF 10V 20% ELEC_ | CT1 PANASONIC EEE-1AA100NR
4MM
51 | 26 | PI3A125 SC70_5 U8-U21,U32- | PERICOM PI3A125CEX
U38,U51-U55
52 4 0.0 1/10W 1% 0603 R13,R14,R16, | PHYCOMP 2322702960011
R17
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ADSP-CM403F EZ-KIT Lite Bill Of Materials

Ref. | Qty | Description Reference Manufacturer Part Number
Designator

53 1 200.0K 1/16W 1% R142 ROHM MCRO1MZPF2003
0402

54 1 IDC 5X2 IDC5x2_ J3 SAMTEC SSW-105-22-F-D-VS
SMT_F

55 1 0.05 10X2 SAMTEC_ P2 SAMTEC SHEF-110-01-L-D-TH
SHF-110-01-L-D-TH

56 | 2 0.5MM 180PIN SAM- | J2,]7 SAMTEC QSH-090-01-F-D-A
TEC_QSH-090-F-D-A

57 1 0.5MM 120PIN SAM- | J9 SAMTEC QSH-060-01-F-D-A
TEC_QSH-060-F-D-A

58 3 0.051 OHM 1/2W 1% | R38,R102,R1 | SEI CSF 1/2 0.05 1%R
1206 09

59 | 2 600 100MHZ 500MA | FERI,FER2 STEWARD HZ1206B601R-10
1206

60 |1 74LVCI14A SOIC14 U3 TI 74LVC14AD

61 1 SN74LVC1G08 U31 TI SN74LVC1G08DBVE
SOT23-5

62 |2 SN74LVC1G08 U29,U30 TI SN74LVC1G08DBVE
SOT23-5

63 |1 RJ11 4PIN CONO039 J8 TYCO 5558872-1

64 1 3A RESETABLE F1 TYCO SMD300E-2
FUS004

65 |1 0 1/8W 5% 0805 R10 VISHAY CRCW08050000Z0EA
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Ref.

Qty

Description

Reference
Designator

Manufacturer

Part Number

66

54

10K 1/16W 5% 0402

R1,R8,R11,R

24-R27,R29,R
35,R41-R43,R
45,R46,R55-R
61,R64-R66,R
69,R73-R76,R
81-R90,R92,R
93,R97-R100,
R104,R112,R

124,R125,R14
3-R146,R224

VISHAY

CRCW040210K0FKED

67

10K 1/16W 5% 0402

R2-R4,R23,R
39,R40,R44,R
54,R126

VISHAY

CRCW040210K0FKED

68

4.7K 1/16W 5% 0402

R22

VISHAY

CRCW04024K70JNED

69

33 1/16W 5% 0402

R9,R62,R63,
R94,R101,R1
20

VISHAY

CRCWO040233R0JNEA

70

10 1/10W 5% 0603

R34,R71,R72,
R107

VISHAY

CRCWO060310R0JNEA

71

30A GSOT05 SOT23-3

D2

VISHAY

GSOT05-GS08

72

30A GSOT03 SOT23-3

D1,D3

VISHAY

GSOT03-GS08

73

22UF 16V 10% 1210

C45-C47,C96
-C98

YAIYO
YUDEN

EMK325B]226KM-T
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ADSP-CM403F EZ-KIT
SCHEMATIC

A NA L OG 20 Cotton Road

Nashua, NH 03063

D EVI CES PH: 1-800-ANALOGD

Title ADSP-CM403F EZ-KIT
TITLE
Size | Board No. Rev
Cze oard No A0342-2012 1.0
Date 08/27/2013 | Sheet of 10
B c P




A B C D
UL 3.(3)v
PA_00/PWMO_SYNC/SPTL ACLK m— %A 00/PWMO_SYNC/SPT1 ACLK _ s _
ST p PC_O0/CANO_TX/SPTL_BTDVUARTL TX/SMCO_A04A45 g PC_00/CANO_TX/SPT1 _BTDVUARTL TX/SMCO_AO4
PA_O01PWMO_TRIPOSPTL_AFS m— 19pA 01PWMO_TRIPO/SPTL_AFS - T
N PC_01/UARTO_RX/SMCO_AOS/TMO_ACI5#2 @ PC_OL/UARTO_RX/SMCO_AO5/TMO_ACI5 i )
PA_02/PWMO_AH/SPT1_ADO m—14PA 02/PWMO_AH/SPT1 ADO _ - b1 _ - N m JTG_TMS/SWDIO
1 PC_02/UARTO_TX'TRACE_D3/SPI0_RDY#L g PC_02/UARTO_TXTRACE_DO3/SPI0_RDY q A
PA_03/PWMO_AL/SPT1 AD1 ®—13pA 03/PWMO_AL/SPTL AD1 ho R114 0 NI B JTG_TCK/SWCLK
1 PC_03/SPI0_CLK/PWM2_CH*—— I3~~~ _~0 a PC_03/SPI0_CLK/PWM2_CH 5 5
PA_04/PWMO_BH/SPT1 BCLK m—12pA 04/PWMO_BH/SPTL BCLK o + + m JTG_TDO/SWO )
1 PC_04/SPI0_MISO/PWM2 CLBY = PC_04/SPI0_MISO/PWM2_CL . A pin 7 cut
PA_05/PWMO_BL/SPT1 BFS m—tlpA 05/PWMO_BL/SPTL BFS - ~ N 1B u TG TDI
10 PC_05/SPI0_MOSI/PWM2_DH®® = PC_05/SPI0_MOSI/PWM2_DH 9 10 R128 0
PA_06/PWMO_CH/SPTL BDO ®=—10pA 06/PWMO_CH/SPT1 BDO - - el W 128 m JTAG_BOARD_RESET
PC_06/SPI0_SELL/PWM2_DL/SYS_DSWAKEOS? g PC_06/SPI0_SELL/PWM2_DL/SYS_DSWAKEOQ
PA_07/PWMO_CL/SMCO_AMS2/SPTL BD1 m— 8PA 07/PWMO0_CL/SMCO_AMS2/SPT1_BD1 s oy 2 m PB_00/PWMO_DH/TRACE_CLK/SPTO_ACLK/SMCO_DOS/CNTO_ZM
] PC_07/SINCO_CLK1/UART2_TX/UARTL_RTS/SYS DSWAKELSS g PC_07/SINCO_CLK1/UARTZ_TX/UARTL_RTS/SYS_DSWAKEL N ¥
PA_08/PWM1_CH/SMCO_DOO/TMO_ACLK5 ®——PA 08/PWM1_CH/SMCO_DOO/TMO_ACLKS 4+ o+ m PB_01/PWMO_DL/TRACE_DOO/SPTO_AFS/SMCO_DOS/CNTO_UD
PA_09/PWM1_CL/SMCO_DOL/TMO_ACLK4 m—OpA_0o/PWM1_CL/SMCO_DOL/TMO_ACLK4 15 | | 16 m TRACE_DO1/JTG_TRST
PA_10/PWM1_SYNC/SMCO_D02/TMO_ACLK3 ®——2PA_10/PWM1_SYNC/SMCO_D02/TMO_ACLK3 iy 18 m PB_03/PWM1_DL/TRACE_DO2/SPTO_AD1/SMCO_D11/CNTL_ZM
PA_11PWML_TRIPO/JUARTL_CTS/SMCO_D03/TMO_ACLK2 m— 4PA_11PWM1_TRIPO/UARTL_CTS/SMCO_DO3/TMO_ACLK2 19 | 4 20 m PC_02/UARTO_TXTRACE_DO3/SPI0_RDY
PA_12/PWM1_AH/TMO_TMR4/SMCO_D04 B 3pA_12/PWM1_AH/TMO_TMR4/SMCO_D04 SAMTEC_SHF-110-01-L-D-TH
PA_13/PWM1_AL/TMO_TMR5/SMCO_D05 B——2PA 13/PWM1_AL/TMO_TMR5/SMCO_DO5 v
PA_14/PWM1_BH/TMO_TMR6/SMCO_D06 m——LL7pA 14/PWM1_BH/ITMO_TMR6/SMCO_DO6
PA_15/PWM1_BL/TMO_TMR3/SMCO_D07 m——19pA 15/pwM1 BL/TMO_TMR3/SMCO_DO7

PB_00/PWMO_DH/TRACE_CLK/SPTO_ACLK/SMCO_DO8/CNTO_ZM l—gng]‘zs/\/\/\/MPB_OO/PWMO_DH/TRACE_CLK/SPTO_ACLK/SMCO_DOB/CNTO_ZM PB_02/PWM1_DH/TRACE_DO1/SPTO_ADO/SMCO_D10/CNTO_DG &1523 0 TRACE_DO1JTG_TRST
PB_01/PWMO_DL/TRACE_DOO/SPTO_AFS/SMCO_DO9/CNTO_UD l—gzilolze/\/\/\/MPB_m/PWMO_DL/TRACE_DO/SPTO_AFS/SMCO_DOQ/CNTO_UD JTG_TRST_CONN &152 gNP
PB_02/PWM1_DH/TRACE_DOL/SPTO_ADO/SMCO_D10/CNTO_DG ®——— il o~~~ 0 112pp 92/pwi1_DH/TRACE_D1/SPTO_ADO/SMCO_D10/CNTO_DG
PB_03/PWM1_DL/TRACE_D02/SPTO_AD1/SMCO_D11/CNTL ZM m——RI8~ ~ ~ ~ 0 1llpg 43pwm1_DL/TRACE_D2/SPTO_ADL/SMCO_D1L/CNTI_ZM

PB_04/PWM2_SYNC/UARTO_RTS/SPTO_ATDV/SMCO_D12/CNT1_UD m— 110pB 04/PWM2_SYNC/UARTO_RTS/SPTO_ATDV/SMCO_D12/CNT1_UD a3y
PB_05PWM2_TRIPO/UARTO_CTS/TMO_TMR7/SMCO_D13/CNT1_DG m— 207pB_05PWM2_TRIPO/UARTO_CTS/ITMO_TMR7/SMCO_D13/CNT1_DG ®)
PB_06/PWM2_AH/TMO_CLK/SMCO_D14 m—195pB 06/PWM2_AH/TMO_CLK/SMCO_D14
PB_07/PWM2_AL/TMO_TMRO/SMCO_D15 m—108pB 07/pWM2_AL/TMO_TMRO/SMCO_D15
103 Py ——— |
PB_08/PWM2_BH/TMO_TMR1/UART1_RX/SMCO_ARDY/TMO_ACI2 m—103pB_08/PWM2_BH/TMO_TMRLUARTL_RX/SMCO_ARDY/TMO_ACI2
PB_09/PWM2_BL/TMO_TMR2/UARTL_TX/SMCO_ARE m— 104pB 09/PWM2_BL/TMO_TMR2/UARTL_TX/SMCO_ARE JTAG/SWD
PB_10/SINCO_CLKO/SPI0_D2/CAN1_RX/SMCO_AWE/TMO_ACI1 m— 102pB 10/SINCO_CLKO/SPI0_D2/CAN1_RX/SMCO_AWE/TMO_ACI1 R4 R8 R2
PB_11/SINCO_DO/SPI0_D3/CAN1_TX/SMCO_AMSO/TMO_ACLK1 m— 90PB_11/SINCO_DO/SPIO_D3/CAN1_TX/SMCO_AMSO/TMO_ACLK1 gﬁg gﬁ’g gﬁ)g b1
PB_12/SINCO_D1/UART2_RX/SMCO_AOETMO_ACI3 m— 51pB_12/SINCO_D1/UART2_RX/SMCO_AOE/TMO_ACI3 1. 12
PB_13/SINCO_D2/CNTO_OUTA/SPIO_SEL2/SMCO_AOL/TMO_ACLKO/SYS_DSWAKE3 m— 48PB_13/SINCO_D2/CNTO_OUTASPIO_SEL2/SMCO_AOL/TMO_ACLKO/SYS_DSWAKE3 3TG_TRST CONN = _ 3, 44
PB_14/SINCO_D3/CNTO_OUTB/SPIO_SEL3/SMCO_A02/SPI0_SS/SYS_DSWAKE2 m— 46PB_14/SINCO_D3/CNTO_OUTB/SPIO_SEL3/SMCO_A02/SPI0_SS/SYS_DSWAKE2 JTG.TDI ® 5, 4+ B
PB_15/CANO_RX/SPT1_ATDV/UART1_RX/SMCO_AO3/TMO_ACI4 m— 47PB_15/CANO_RX/SPT1_ATDV/UART1_RX/SMCO_AO3/TMO_ACI4 JTG_TMS/SWDIO = 1, 48
9 10
ADSP-CMA403BSWZ JTG_TCKISWCLK m o
QFPS40P1600X1600X160-121N W, o
3.3V
JTG_TDO/ISWO = 13 4 4 pa O
JTAG_BOARD_RESET = 15 4 6
17, 18
3.3V 19 | | 20
|
TE 51033085 T 01UF
. 0402
R124< R125
_ R127 0 e 10K 10K
B T ——— =&
JTG_TRST_CONN R JTG_TRST < 2ok,
R126
10K
0402
, _us1 DNP "
SYS_HWRSm—1 | 4
, . m JTG_TRST
JTG_TRST_CONN m—2|
SN74LVC1G08
SOT23-5 N
DNP 3.3V
O
| cao
T 0.1UF
0402
33V Z ;
U1
28 R121 0 R6 Y1 R7
=~ T ————— 1
Twio_sc Rial TWI0_SCL A . A
Twio_SDAZ2 m TWIO_SDA 33V 9102 oScors o102
JTG_TCKISWCLK ® 3137G_TCKISWCLK svs_BMODEOLZ2 m SYS_BMODEO DSP OSC SYS_XTAL E SYS_CLKIN
R119 0 34 119 R8 TP1
PR U L .|
JTG_TMS/SWDIO R JTG_TMS/SWDIO SYS_BMODEL m SYS_BMODE1 N c3 o2
30 P4 0402 18PF 18PF
JTG_TDI = ITG_TDI SYS_CLKIN m SYS_CLKIN RO aos aos
RS 0 33 118 R120 33 u2s 33 DNP DNP
[P 3> N P L L S A L U & E—
JTG_TDO/SWO R JTG_TDO/SWO SYS_CLKOUT, R SYS_CLKOUT i o
JTG_TRST = 3237G_TRST Svs_XTALEE B SYS_XTAL 10 outs SYS_CLKIN
1 —_— GND
SYS_HWRST! m SYS_HWRST e
svs_nmiE2 m SYS_NMI 0sco12 TP10 v
svs_FAULTZY m SYS_FAULT
SYS_RESOUTES m SYS_RESOUT 3'5\’
ADSP-CM403B5WZ Z ;
QFPS40P1600X1600X160-121N
A NA L OG 20 Cotton Road
Nashua, NH 03063
c4 )
—— GowF DEVICES Pp+:1-800-anaL0GD
0402
Title ADSP-CM403F EZ-KIT
< PROC, JTAG/SWD AND TRACE CONN, CLOCK
Size | Board No. Rev
- A0342-2012 N
Date 08/27/2013 | Shest > of 10
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A B C D
R10 39
U1 0
o3 DACO_VOUT 2= DAC0_vouT 0805 O
ADCO_VINOO m—————23ADCO_VINOO DACL VOUTP®— & DACL VOUT A VAVAVAS
ADCO_VINO1 m—————22 ADCO_VINO1
ADCO_VINO2 B—————55ADCO_VINO2 ADCO_VINOO B———— 1| — 2 = ADCO_VINO1
ADCO_VINO3 m—————¢2JADCO_VINO3 La 3 4
ADCO_VINO4 m—————22 ADCO_VINO4 BYP_AO:> @ BYP_AQ ADCO_VINO2 = 5 < 6 m ADCO_VINO3
ADCO_VINO5 m————2{ADCO_VINOS BYP_Alge & BYP_Al 7 = 8
ADCO_VINOG6 m—————c2 ADCO_VINOB BYP_DOS2 & BYP_DO ADCO_VINO4_EXP_CONN = 9 L 10 m ADCO_VINO5
ADCO_VINO7 ®——————¢=ADCO_VINO7 REFCAPI™>——m REFCAP N 11 12
ADCO_VINO8 B—— 54 ADCO_VINO8 ADCO_VINO6 = 13 14 m ADCO_VINO7
83 AGND 15 16
ADCO_VINO9 m————— 22 ADCO_VINO9 R147 0 —
ADCO_VIN1O m—————22ADCO_VIN10 e 3.3V ADCO_VINO8 = 0402 17 18 m ADCO_VINO9
ADCO_VIN11 m——S2ADCO_VIN11 VREFO 75— VREF0 ; 19 20
57 VREF17e——& VREF1 ADCO_VIN10 = 21 N 22 m ADCO_VIN11
ADC1_VINOO m—————28ADCI_VINOO GND_VREF0 7 23 = 24
ADC1_VINO1 m—————25ADCI_VINOL GND_VREF1 ADC1 VIN11 m 25 26 m ADC1_VIN1O
ADC1_VINO2 m—————25ADCI_VINO2 2 ! 28
ADC1_VINO3 m——2JADC1_VINO3 ADC1_VINO9 m 29 30 m ADC1_VINO8
62 31 ADC 32
ADC1_VINO4 m————— 22 ADCI_VINO4 50 a "
ADC1_VINO5 m———22 ADC1_VINOS VDD_ANAO ° ADC1_VINO7 = — m ADC1_VINO6
ADC1_VINO6 m————SHADCI_VINOG VDD ANALIQ T R148 R 136 o
ADC1_VINO7 =———22 ADC1_VINO7 ADC1_VINO5 ® 37 38 B ADC1_VINO4_EXP_CONN
ADC1_VINOS m——99apciviNos 0402 39 9 40
— 67 — 79 a1 S 42
ADC1_VINO9 m——————4ADCI_VINO9 GND_ANAO 77 ADC1_VINO3 m m ADC1_VINO2
ADC1_VIN10 m—————2ADCI_VIN10 GND_ANAL o= 43 44
ADC1_VIN11 m——92ADCI VIN11 GND_ANA2 ADC1_VINO1 = 45 L 46 = ADCI_VINOO
GND_ANA3[2L o 4
ADSP-CM4038SWZ DACO_VOUT_EXP_CONN = o DAC 2 m DACL_VOUT
QFPS40P1600X1600X160-121N 53 — 54
o 55 - R J
_ 57| g |58
sv VREF_BUFFERED ® 59 VRER 60 m VREF_BUFFERED
AGND O
121 125
3.3V 122 126
123 127
124 128
us P
2 6 R14 0.0 —a Q; N L@z
® . 4
VIN VOuUT 0603 m VREFO_ADR441 R11 "
10K 67 S 68
c7 1 8 0402 69 L 70
T 01UF TPO TP1 7 72
0402 73 74
cs U22 75 RESERVED 76
45ND TRIM — 0.1UF — ~ 7] 78
0402 1FEEDBACK  DISABLES 79 80
ADR441ARMZ 81| © g2
MSOP8 2HN +VS7 s ﬁ Y
__ 85| 86
R12 24.9 3+IN VOUT6 R137 0 397 - %0
. H+
BUFFER_IN = 0402 R 0403 m VREF_BUFFERED 2 0
4vso zZ  wst? %8 — 94
_ 95 o6
AGND ) ADA4899 © 5V 97 08
SOIC127P602X147-9N 99 ~ 100
5V 101 q 102 5V
103 104
105 L 106
107 108
3.3V 109 110
AGND 111 - 112
Jr 113 114
CT1 Cl04_ | C5 115 © 116
u2 10UF 0.1UF___ 0.01UF o 117 Y 118 .
ELEC_4MM | 0402 0402 T 119 L 120 ¢
2N vouTe o N33 00 o VREF1 ADR441 AGND POWER
C103 8 O
—— O1UF TPO TP1
0402 SAMTEC_QSH-060-F-D-A
C102
4 0.1UF
ND  TRIM 0402 AGND
ADR441ARMZ
MSOPS8
AGND AGND
AGND \ R134 R149
R136 0 0
0 0402 0402
0402 ADCI_VINO4_EXP_CONN m———/\ /\ /\ /\——e—/\ A\ /\ /=  ADC1_VINO4
ADCO_VINO4_EXP_CONN ADCO_VINO4
J6
AGND Ja SMC R133
SMC AMPHENOL_152119 0
JP1 JP3 AMPHENOL_152119 DNP 0402
VREFO_ADR441 44 VREFO m— 1+ DNP 0202 oo ADC1_VINO4_SMC DNP
9 b VREF_BUFFERED ®— P3 ADCO_VINO4_SMC 6402 Q
VREFO =+ =+ BUFFER_IN 1 n P11 Q DNP
IDC2X1 VREFO_ADR441 B—— 3 A
IDC3X1 +
IDC2X1
JP2
1
N |
VREF1_ADR441 =+ AGND
2
2
VREF1 + AGND
IDC2X1 AGND
R132
SJ2 SJ3 AGND 0
SHORTING SHORTING 0402
JUMPER JUMPER
DEFAULT=UNINSTALLED DEFAULT=1 & 2 DACO_VOUT_EXP_CONN ® VAVAY #—® DACO_VOUT
J5
SJ1 SMC 0
SHORTING AMPHENOL_152119 R131
JUMPER DNP 0402
DEFAULT=UNINSTALLED DNP
Q DACO_VOUT_SMC
3.3V 3.3V
O O
BYP_DO m— BYP_AL m— VREF1 REFCAP B— VREFO BYP_AO m—
AGND
20 Cotton Road
| c17 | cwo | c16 | ci18 c12 | c100 | c13 ci4 | ci1o1 | c15 | co | c11
1UF 10UF 0.1UF 10UF 10UF 0.1UF 0.1UF 10UF 0.1UF 10UF 10UF 0.1UF
T 0402 T 0603 | 0402 “T 0603 T 0805 | 0402 T 0402 T 0805 | 0402 T 0402 T 0603 | 0402 Nashua, NH 03063
DEVICES Pp+:1-800-anaL0GD
Title ADSP-CM403F EZ-KIT
\ ANALOG CONN, POWER
AGND AGND AGND AGND AGND AGND AGND
Pins 55- Pins 80-79 Pins 72-71 Pins 73-74 Pins 75-74 Pins 77-76 Pins 78-79 Pins 70-71 5'Cze Board No. A0342-2012 1.0
Center pad :
Date 08/27/2013 | Shest 3 of 10
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A B C D
3.3V
VDD_EXT  VDD_INT
[ ] [ ]
R15
Ut 0 o5 P12
19vop_INTO DNP TP3
24 VDD_INT1 b6
3% VDD_INT2 VDD_VREG
o0 VDD_INT3
VDD_INT4 .
2\vDD_EXTO
VDD_EXT1
JVDDZEXT2 VREG_BASE 22 ° R20 X
22 /DD_EXT3 s SYS_CLKOUT
. VDD_EXT4
30 VDD_EXTS 33V o1
49\DDExT7 . 1 STD2805T4
53/DD_EXT? TO228P972X240-3N
97\Dp_EXTY 33V
100,55 EXT10 R21
109 VDDEXT10 R17 < R16 2 0
116DD-EXT11 00 00 1206 33V
95 /DD_EXT12 0603, 0603 DNP
100V00-EXT1y R19 . = VDD_INT T(P)? 33V T(P)G 33V T(P)S 3.5v
e e
52 LED6
GNDO
GND1 %2 N4 "FAULT" T, (€0 oe0z
N LED-
121 R24 R29
GND_PADDLE R27 R26 R25 10K 10K
| c20 | cio 10K 10K 10K 0402 0402
ADSP-CMAO3BSWZ ~ T 10UF 01UF 0402 0402 0402
QFPS40P1600X1600X160-121N R18 0805 0402
0
%102 TWIO_SCL
TWIO_SDA ®
q
v SYS_FAULT
VDD_EXT SYS_RESOUT = o
_ NOTE SYS_NMI =
SYS_HWRST JTG_TRST
G L2 INTERNAL REGULATOR N N
T 066 T 0402 NOTE: CONNECT PIN 98 DIRECTLY TO GROUND
REMOVE R17, R16, P4, R38, R33
FOR CUSTOMER DESIGNS ’ P ’ Tk hok
INSTALL R21, R15, R32 oD bR
EXTERNAL REGULATOR
AGND
Pins 95-90 REMOVE R21, R15, R32
INSTALL R17, R16, P4, R38, R33
S¥4
i SHORTING
JUMPER
DEFAULT=INSTALLED
P8 _
1.2V @ 1.5A ©  "vDD INT" Remove P4 when measuring VDD_INT
E\)/ P4
1 2
T T
IDC2XT
R34
10 VR1
0603 L1 R38 VDD_INT
. 1 L5UH 0.05
IND003 1206
ZovIN swe 3 2ean
0
» TRk 0402
SYNC/MODE2 o D1
| ca3 R33 R35 GSOT03
— T 01UF | c45 0 | caa 10K SOT233
0402 —  20UF 0402 —  0.1UF 0402
1210 0402 8
PGOO
R31
27K
0402
o« 10eN el I
GND PGND EPAD
ADP2119ACPZ-R7 — 11
DFN50P300X300-11N "
" R32 R37 R30 TP13
0 0 27K
0402 0402 0402
DNP DNP
S
o————4
VDD_EXT
VDD_INT
A NA L OG 20 Cotton Road
Nashua, NH 03063
c24 c22 c25 c23 c21 c3a c37 38 c40 )
10UF  01UF  01UF _ 0.01UF __ 0.01UF 10UF  10UF  01UF _ 01UF _ 0.1UF 01UF  01UF  01UF _ 0.01UF 0.01UF 0.01UF 0.01UF 0.01UF 001UF — 0.01UF D EV I C ES PH: 1-800-ANALOGD
0402 0402 0402 0402 0402 0402
Title ADSP-CM403F EZ-KIT
DIGITAL POWER, VDD _INT
Size | Board No. Rev
i A0342-2012 =
Date 08/27/2013 | Shest of 10




A B C D
33V
O
33V
Q 12C address 0100 000
R224
10K
0402 u27
5 17
Uss VDD cPAt —
TRACE_EXP_EN 15E 4 cPAal™® — w PB 10 37 EN
. TWIO_SCL SCL 19
PB_00/PWMO_DH/TRACE_CLK/SPTO_ACLK/SMCO_DO8/CNTO_ZM A 4 m PB_00/PWMO_DH/TRACE_CLK/SPTO_ACLK/SMCO_DOS/CNTO_ZM_EXP 9 ePA2t2 — w PB 11 37 EN
STEATIE TWIO_SDA = SDA ho
L m
G705 GPA3 UARTORTS_EN
SYS_HWRST = 14RESET GPA42l — u UARTORX EN
= 18 GPAS2Z— m UARTOCTS_EN
J o —18nTA b3
9 1 GPAGZ2— @ UARTOCTS_RTS_LPBK
PB_01/PWMO_DL/TRACE_D00/SPTO_AFS/SMCO_DO9/CNTO_UD A 4 = PB_01/PWMO_DL/TRACE_DOO/SPTO_AFS/SMCO_DO9/CNTO_UD_EXP —13\TB b4
GPA7T?Y—m UARTOCTS RST_EN
PI3A125
SC70 5 I
f ' 25 —
2w
Us3 GPBOQ CANO_EN
1o cPB1®® @ PUSHBUTTONI EN
PB_02/PWM1_DH/TRACE_DO1/SPTO_ADO/SMCO_D10/CNTO_DG 2 4 m PB_02/PWM1_DH/TRACE_DOL/SPTO_ADO/SMCO_D10/CNTO_DG_EXP R39 < Ra0 GPB22L @ PUSHBUTTONZ_EN
PI3A125 0402 0402 28 —
S m
SC70_5 DNP <~ DNP GPB3 LED1_GPIO1_EN
" - T
|
us2 GPB4 LED2_GPIO2_EN
15 Lo GPB52— m LED3_GPIO3_EN
PB_03/PWM1_DL/TRACE_D02/SPTO_AD1/SMCO_D11/CNT1_ZM 20 4 = PB_03/PWML_DL/TRACE_DO02/SPTO_AD1/SMCO_D11/CNT1_ZM_EXP 1251 GPB6S—m TRACE EXP_EN
PI3A125 13 4 —_—
A
S0 o 130 GPB7 SPIFLASH_J2_EN
MCP23017
us1 QFNB5P600X600-29N
17
E R42 <~ R43 < R4l 3.3V
PC_02/UARTO_TXTRACE_DO03/SPI0_ RDY m— 2p A @ PC_02/UARTO_TXTRACE_DO03/SPI0_RDY_EXP 10K 10K 10K O
-~ - - - - - - Y 3.3V 0402<_ 0402<_ 0402
PI3A125 O
SC70 5
o SOFTCONFIG
| cas
3.3V T 0.0LUF
0402
R100
10K Z ;
0402
u36 N4
- 000000000 17
c174 c173 c172 c171 c170 SPIFLASH_J2 EN = E
~ 01UF___ 0.0LUF 0.01UF 0.01UF 0.01UF 2, 4
O10m o oo oo T PC_03/SPI0_CLK/PWM2_CH = A B m PC_03/SPI0_CLK/PWM2_CH_J2 U38
PI3AL125 SAND EN 1=
‘ R CANO_EN_INVERTED m E
PC_00/CANO_TX/SPT1_BTDVUARTL TX/SMCO_AO4 m 25 B% @ PC_00/CANO_TX/SPTL_BTDVUARTL TX'SMCO_AO4_EXP
uss PI3AL125
1sg SC70 5
: PC_05/SPI0_MOSI/PWM2_DH = 20 BY = PC_05/SPI0_MOSI/PWM2_DH_J2 2
PI3AL125 E
SC70_5 PB_15/CANO_RX/SPT1_ATDV/UART1_RX/SMCO_AO3/TMO_ACI4 m— 25 B* @ PB_15/CANO_RX/SPT1_ATDV/UART1_RX/SMCO_A03/TMO_ACI4_EXP
u34 PI3AL25
1se SC70 5
PC_04/SPI0_MISO/PWM2_CL = 20 BY = PC_04/SPI0_MISO/PWM2_CL_J2 33V
PI3AL125
SC70 5
u33 us
15 CANO_EN 1 2 CANO_EN_INVERTED
PB_10/SINCO_CLKO/SPI0_D2/CANL_RX/SMCO_AWE/TMO_ACIL m 2 g% PB_10/SINCO_CLKO/SPI0_D2/CANL RX/SMCO_AWE/TMO_ACIL_J2 74LVC14A c113 112
PI3A125 soic14 ~ 01UF__ 0.01UF
SC70 5 0402 0402
u32 THE OTHER GATES OF U3 ON PUSHBUTTON PAGE
10
PB_11/SINCO_DO/SPI0_D3/CANL_TX/SMCO_AMSOTMO_ACLKL m— 25 BY = PB_11/SINCO_DO/SPI0_D3/CANL_TX/SMCO_AMSO/TMO_ACLKL J2
PI3AL125
SC70 5
3.3V

PB_10/SINCO_CLKO/SPI0_D2/CAN1_RX/SMCO_AWE/TMO_ACI1 =

PB_11/SINCO_DO/SPI0_D3/CAN1_TX/SMCO_AMSO/TMO_ACLK1 m

0.1UF

C110
0.01UF

C109 c108 | c6
0.01UF 0.01UF ___ 0.01UF
0402

NS

PB_10_J7 EN =

[ 0402 0402 0402 0402

uUs

OE

A

A

g4 m PB_10/SINCO_CLKO/SPIO_D2/CAN1_RX/SMCO_AWE/TMO_ACI1_J7

PI3A125
SC70_5

U9

PB_11 J7 EN =

OE

A

R46 R45

10K 10K

0402 0402
. ]

A

g4 m PB_11/SINCO_DO/SPIO_D3/CAN1_TX/SMCO_AMSO/TMO_ACLK1_J7

PI3A125
SC70_5

C52
0.1UF
0402

A NA L OG 20 Cotton Road

Nashua, NH 03063

e DEVICES Pp+:1-800-anaL0GD
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MEMORY AND SOFTCONFIG
Size | Board No. Rev
Cze oard No A0342-2012 1.0
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3.3V

3.3V
O
col | cs5 U23
~ " 10UF 01UF —  0.1UF \
0805 0402 0402 o Moco | visootld o o .
33y Blvccl wsm%
O VCC2 ‘ VISO2
¢ | css co2 | ceo
1UF 10UF 0.1UF
0402 0805 | 0402 RS 232
N | e i
B11 10UF
| v 0402 »
| e } } c58
R54 R56 R55 cLELL 0.10UF
10K 10K 10K | 0402
0402 0402 0402 c24G11 | |
o | G10 | ‘ GND2 a1
u10 ‘ C2-
UARTORTS_EN I5e -
_ PC_02/UARTO_TXTRACE_DO3/SPI0_RDY w— Dlpng ‘ TouT1R1L 7{)
PB_04/PWM2_SYNC/UARTO_RTS/SPTO_ATDV/SMCO_D12/CNT1_UD 2, gt Flrinz TouT2FiL 6
PI3A125 | O
SCT0-0 R63 33 H1 \ H11 2 Q
ouT1 RIN1
a0z 23 yiKlROUTZ | RINzK1L 7 O
U1l 0402 3 Q
UARTORX_EN OE a1 ‘ 8
PC_01/UARTO_RX/SMCO_AOS/TMO_ACI5 A g SEG“BE | v oLl 4
PI3AL125 I ElNDa < >
SC70 5 E2CNDg | ] 9
ND5
R57 R58 GIcND  IoND_I1S00D10 > Q
ok <Ak, Sonpr  GNDISOIESS
H2GND8  [GND_ISO2 20 c59 CONO38
JIGND9  GND_ISO3HS —— 5 10UF DB9
¢ J2GND10  |GND_ISO4 -0
K2GnD11  'GNDIS05K10 0402
A LZoND12 ‘GND:ISO"L]'O
ADM3252E
BGA44C100P11X11_1200X1200X103
GND2
3.3V V% v
GND2 GND2
o———4¢
R59 R60 R61
10K 10K 10K
0402 0402 0402 Loy
u12 BOOT MODE SWITCH (SW1)
UARTOCTS_EN ° OE
PB_05PWM2_TRIPO/UARTO_CTS/TMO_TMR7/SMCO_D13/CNTL_DG A B Bootmode (1:0)
S5 00 No Boot
u13 — é:jép é:ﬁgp é:jng %}:: §}£F Default 01 SPI Master Boot (internal SPI12)
UARTOCTS_RTS_LPBK OF
P B 1™ 10 SPI Slave Boot (SPIO)
SCr0 5 11 UART Boot (UARTO)
U4 <7
UARTOCTS_RST_EN OE
TS A B a3y
PI3A125
SC70 5
swi
€ L2, 1 m SYS_BMODEO
2 m SYS_BMODE1L
0 al,
7 5
5
SWT027
ROTARY
R64 R66 R65
10K 10K 10K
0402 0402 0402
A NA L OG 20 Cotton Road
Nashua, NH 03063
DEVICES Pp+:1-800-anaL0GD
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RS-232, BOOT CONN
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A B C D
CANO_VISO
3.3V 5V CANO_VISO
. CANO_CANH R139
0
0402
u26 ‘ DNP
8 19 R67 R72
vCC ‘ VISOIN A 0
610 ‘ 0603 0603 J8
12 1
U6 VISOOUT|
CANO_EN = 15 | 14 CANO_VREF oo o 2
I VREF L
PC_00/CANO_TX/SPT1_BTDVUART1_TX/SMCO_A04 m 25 Bt CANO_TX TXD ‘ 17 0402 3
CANH
PI3A125 CANO_RX 15 4
SC70.5 RXD \ CANL
RSt
u15 ‘ R70 R71 CONO39
1 1 60.4 10 RJ11
E 3GNDL0 | GND2 ol 0603 0603
PB_15/CANO_RX/SPT1_ATDV/UARTL_RX/SMCO_A03/TMO_ACl4 m 2\ B ; ND1 2 ‘ GND2:112 70
PI3AL25 o 1oND-3 N0 3 R69 ~ 4700PF
SC70_5 = — 10K 0603
- ‘ 0402 CANO_CANL
R73 ADMB3053
10K SOIC127P1032X265-20N
0402
3.3V Z ; ¢ ¢
3.3V 5V N S CANO_VISO CANO_VISO
GND3
ce | crr
~ 0AUF___ 0.1UF
0402 0402
cri | cm c69 | ce8
( A N O 0.01UF ___ 0.1UF 0.01UF ___ 0.1UF
c67 | cra crs | cr3 0402 0402 0402 0402
~ 0.01UF ___ 0.UF ~ 10UF —_ 0.1UF
0402 0402 0805 0402
GND3 GND3

NS

Place between pins 6 and 7

NS

Place between pins 8 and 9

20 X 2 Character Display

J3
+ +

+ +
+ +

TWIO_SDA_DISPLAY =

5V
cis | c7

T 1I0UF __ 0.1UF
0805 0402

+ +
0+

TWIO_SCL_DISPLAY

J\ 02

IDC5X2_SMT_F

Place between pins 11 and 12

u24

ND

SREF

TWIO_SCL ®

S1

DO N

TWIO_SDA =

S2

R140
680
0402

GREHF

DREF

D1

g o [N [©

® TWIO_SCL_DISPLAY

GTL2002
TSSOP8

® TWIO_SDA_DISPLAY

| C106
— 0.01UF
0402

| c105
~ 0.01UF
0402

| c107
~ 0.01UF
0402

Place between pins 19 and 20

A NA L OG 20 Cotton Road

Nashua, NH 03063

D EVI CES PH: 1-800-ANALOGD

Title ADSP-CM403F EZ-KIT
CANO, DISPLAY
Size | Board No. Rev
Cze oard No A0342-2012 1.0
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J2

J7

O
- 1 2 @ PB_13/SINCO_D2/CNTO_ OUTALSEID_SELZ/SMCO _A01/TMO_ACLKO/SYS_DSWAKE3 PA_00/PWMO_SYNC/SPT1 ACLK m=—— 1 — 2 m PA_01PWMO_TRIPO/SPT1_AFS
PB_14/SINCO_D3/CNTO_OUTB/SPI0_SEL3/SMCO_AQ2/SPI0_SS/SYS DSWAKE? w3 | 14 u PB_15/CANO_RX/SPT1 _ATDV/UART1_RX/SMCO_A03/TMO_ACI4_EXP - - - 3 4
PC_00/CANO_TX/SPT1_BTDVMUART1_TX/'SMCO_A04_EXP -73 24- PC_01/UARTO_RX/SMCO_A05/TMO_ACI5 PA 02/PWMO AH/SPT1 ADO = g < g m PA 04/PWMO BH/SPT1 BCLK
-
151’ g PA_03/PWMO_AL/SPT1_AD1 ® 15; L 1‘2) m PA_05/PWMO_BL/SPT1_BFS
13 ADDRESS 14 13 14
a PA_06/PWMO_CH/SPT1_BDO = 3 B " m PB_00/PWMO_DH/TRACE_CLK/SPTO_ACLK/SMCO_DO8/CNTO_ZM_EXP
17 T T PA_07/PWMO_CL/SMCO_AMS2/SPT1_BD1 17 18
. _ B | = 1 8 m PB_01/PWMO_DL/TRACE_DOO/SPTO_AFS/SMCO_DO09/CNTO_UD_EXP
21| & 122 21 N 22 PA_11PWM1_TRIPO/UART1_CTS/SMCO_D03/TMO_ACLK2
& PA_10/PWM1_SYNC/SMCO_D02/TMO_ACLK3 = 2 g 2 m PA_ _ | _ .
_ 25| 26 [ 25| 26 |
| ] PA_12/PWM1_AH/TMO_TMR4/SMCO_D04 m— 2 | ] 2 —a PA_14/PWM1_BH/TMO_TMR6/SMCO_DO06
_ 29| 30 29 30
PA_13/PWM1_AL/TMO_TMR5/SMCO_D05 a o pos m PA_15/PWM1_BL/TMO_TMR3/SMCO_D07
33 - 34 PA_08/PWM1_CH/SMCO_DOO/TMO_ACLK5 = 33 — 34 m PB_02/PWM1_DH/TRACE_DO01/SPTO_ADO/SMCO_D10/CNTO_DG_EXP
PA_08/PWM1_CH/SMCO_DOO/TMO_ACLK5 = 35 36 m PA_09/PWM1-CL/SMCO-DOLTIMO ACLK4 35 36
PA_10/PWM1_SYNC/SMCO_D02/TMO_ACLK3 = 37 " 38 m PAZ11PWMI1_TRIPO/UART1_CTS/SMCO_DO03/TMO_ACLK2 PA_09/PWM1_CL/SMCO_DO1/TMO_ACLK4 = 37 38 m PB_03/PWM1_DL/TRACE_DO02/SPTO_AD1/SMCO_D11/CNT1_ZM_EXP
PA_12/PWM1_AH/TMO_TMR4/SMCO_D04 ® 39 3 40 m PA_13/PWM1_AL/TMO_TMR5/SMCO_DO5 — 39 e 40
PA 14/PWM1 BH/TMO TMR6/SMCO D06 = 41 42 m PA 15/PWM1 BL/TMO TMR3/SMCO DO7 PB_04/PWM2_SYNC/UARTO_RTS/SPTO_ATDV/SMCO_D12/CNT1_UD m 41 ol 42 m PB_05PWM2_TRIPO/UARTO_CTS/TMO_TMR7/SMCO_D13/CNT1_DG
PB_00/PWMO_DH/TRACE_CLK/SPTO_ACLK/SMCO_DO8/CNTO_ZM EXP 43 44 m PB_01/PWMO_DL/TRACE_DO00/SPTO_AFS/SMCO_D09/CNTO_UD_EXP 43 44 —
PB_02/PWM1_DH/TRACE_DO1/SPTO ADO/SMCO D10/CNTO DG _EXP W45 L H46 = pPB 03/PWM1_DL/TRACE DO2/SPTO AD1/SMCO D11/CNT1 ZM_EXP PB_06/PWM2_AH/TMO_CLK/SMCO_D14 m——f 45~ L H46 @ PB_08/PWM2_BH/TMO_TMRI/UART1_RX/SMCO_ARDY/TMO_ACI2
PB_04/PWMZ_SYNC/UARTO | RTS’SPTO  ATDV/SMCO_D12/CNTI_UD m 47 48 m PB” OSPWMZTRIPO/UARTO CTS/TI\]I'O TMR7/SMCO_D13/CNT1 DG 47 48
PB_06/PWM2_AH/TMO_CLK/SMCO_D14 451’ DATA 5(2’ m PB_07/PWM2_AL/TMO_TMRO/SMCO_D15 PB_07/PWM2_AL/TMO_TMRO/SMCO_D15 ‘5“1’ gg a PB_09/PWM2_BL/TMO_TMR2/UART1_TX/SMCO_ARE
_ 53| |54 53 54
PC_03/SPI0_CLK/PWM2_CH = 3 5 P m PC_05/SPI0_MOSI/PWM2_DH
— 57 o8 PC 04/SPI0 MISO/PWM2 CL = 57 = 58 m PC_06/SPI0_SEL1/PWM2_DL/SYS_DSWAKEOQ
59 60 - - - 59 1 60
181 181 b
182 182
183 183
184 SINC 184
61| — |62 PB_10/SINCO_CLKO/SPI0_D2/CAN1_RX/SMCO_AWE/TMO_ACI1_J7 m 61 — 62 m PC_07/SINCO_CLK1/UART2_TX/UART1 RTS/SYS _DSWAKEL
63| 2 |64 PB_11/SINCO_DO/SPI0_D3/CAN1_TX/SMCO_AMSO/TMO_ACLK1 J7 m 63 1 64 m PB_12/SINCO_D1/UART2_RX/SMCO_AQE/TMO_ACI3
65| = |66 PB_13/SINCO_D2/CNTO_OUTAISPIO_SEL2/SMCO_A01/TMO_ACLKO/SYS_DSWAKE3 m 65 = 66 m PB_14/SINCO_D3/CNTO_OUTB/SPIO_SEL3/SMCO_A02/SPI0_SS/SYS_DSWAKE2
- 67 68 PB_13/SINCO_D2/CNTO_OUTA/SPIO_SEL2/SMCO_A01/TMO_ACLKO/SYS_DSWAKE3 m 67 68 m PB_14/SINCO_D3/CNTO_OUTB/SPIO_SEL3/SMCO_A02/SPI0_SS/SYS_DSWAKE?2
PB_10/SINCO_CLKO/SPI0_D2/CAN1_RX/SMCO_AWE/TMO_ACI1_J2 w—1f— 59 L HO = PB_12/SINCO_D1/UART2_RX/SMCO_AOE/TMO_ACI3 PB_00/PWMO_DH/TRACE_CLK/SPTO_ACLK/SMCO_DO8/CNTO_ZM_EXP w59 L] HO = PB_01/PWMO_DL/TRACE_DOO/SPTO_AFS/SMCO_DO9/CNTO_UD_EXP
PB_08/PWM2_BH/TMO_TMR1/UART1_RX/SMCO_ARDY/TMO_ACI2 m 71 72 m PB_09/PWM2_BL/TMO_TMR2/UART1_TX/SMCO_ARE PB 02/PWM1 DH/TRACE DO01/SPTO ADO/SMCO D10/CNTO DG EXP = 71 72
PB_11/SINCO_DO/SPIO_| D3/CAN1 TX/SMCO-AMSO/TMO ACLKL J2 = 23 CONTROL s R 13 CNT 74 = PB_03/PWM1 DL/TRAGE D02/SPTO_AD1/SMCO D11/CNTL ZM_EXP
_07/PWMO_CL/SMCO_AMS2/SPT1_BD1 m ;3 % PB_04/PWM2_SYNC/UARTO_RTS/SPTO_ATDV/SMCO_D12/CNT1 UD m ;g e ;6 a PB_05PWM2 TRIPO/UARTO_CTS/TMO_TMR7/SMCO_D13/CNT1 DG
_ 79| 80 _ 79| 80
_ 81| & 82 _ 81| © 82
—83 B &4 ® SYS NMI TWIO_SDA = 83 TWi[~ 84 m TWIO_SCL
SYS_CLKOUT = 85 g6 ® SYS_HWRST PC_03/SPI0_CLK/PWM2_CH = 85 g6 m PC O4/SPIO MISO/PWM2_CL .
87 ] 88 PGC_05/SPI0—MOSI/PWM2 DH = 87 L 88 m PBT10/SINCD_CLKO/SPI0O D2/CAN1_RX/SMCO_AWE/TMO_ACI1_J7
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CraHpapT
INeKTpPOoH
ﬂ CBAA3b

Mbl MOf04aA M aKTUBHO Pa3BMBAIOLLAACA KOMMAHWA B 061acTM  MOCTaBOK
3NEKTPOHHbIX KOMMOHEHTOB. Mbl NOCTAaBASEM  3/IEKTPOHHbIE  KOMMOHEHTbI
OTEYEeCTBEHHOIrO U MMMOPTHOIO NMPOWU3BOACTBA HAMPAMYIO OT NPOU3BOAMUTENEN U C
KpYMHEMLWKNX CKNaZ0B MUpa.

Enaro,a,apﬂ coTpygHn4ecTtesy C MMpPOBbIMU NOCTaBWMKaMWN Mbl OCYLLECTBIAEM
KOMMNNEKCHbIE N NN1aHOBblE MNMOCTABKU LumpoqaﬁLuero CNEeKTpa 3/1EKTPOHHbIX
KOMMOHEHTOB.

CobcTtBeHHan 3¢p@eKTUBHAA NOrMCTUKA M CKNag B obecneunBaeT HageKHYHo
MOCTaBKy MNPOAYKLMM B TOYHO YKa3aHHble CPOKM Mo Bcel Poccum.

Mbl ocyuiecTBisem TEXHUYECKYI0 MNOALEPKKY HAWWM  K/IMEHTaMm U
npeanpoaaxkHyto NPOBEPKY KayecTsa NpoayKumu. Ha Bce noctaBnsiemble NpoAyKTbl
Mbl MPEAOCTaBASEM TFAPaAHTUIO .

OcyuwiectBndem nNOCTaBKM NpoOAYKUMM nog, KoHTponem Bl MO PO Ha
npeanpuATUA BOEHHO-NPOMbIWIEHHOTO KoMnaekca Poccuun , a TakKe paboTtaem B
pamkax 275 ®3 c OTKpbITUEM OTAE/bHbIX CHETOB B YNONHOMOYEHHOM BaHKe. Cuctema
MeHeXMeHTa KayecTBa KomnaHum cooTBeTcTByeT TpeboBaHuam FOCT ISO 9001.

MWHUMaNbHbIE  CPOKM  MNOCTAaBKW, TMOKME  UeHbl, HeorpaHWYeHHbIN
aCCOPTUMEHT UM WHAMBMAYANbHbLIN MNOAXOA K KAMEHTaM ABAAIOTCA OCHOBOW ANA
BbICTPAMBaHMA A0FOCPOYHOIO M 3GPEKTUBHOIO COTPYAHMYECTBA C NPEeANPUATUAMM
PaANO3NEKTPOHHOMW NPOMBIWAEHHOCTU, NPEeanPUATUAMM BMNK u HayuHo-
nccnenoBaTeNbCKUMKU MHCTUTYTaMm Poccun.

C Hamu Bbl CTAaHOBMUTECH elle ycnewHee!

[HaLLIM KOHTAKTbI: \

TenedoH: +7 812 627 14 35

dNeKTpPOHHaA nouTa: sales@st-electron.ru

Appec: 198099, CaHkT-MNeTepbypr,
MpomblwneHHasa yn, gom Ne 19, nutepa H,
nometleHune 100-H Oduc 331
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